[bookmark: _Toc159687879][bookmark: _Toc159688601][bookmark: _Toc159689464]Portland Writers Mill, Feb 2024 Meeting, 
The Efficient Use of Word, with Sheila Deeth et al.
We all have different versions of WORD. The important thing to gain from this session (and from these notes) is not the details of exactly where each button is, but the ideas what might be possible with word-processing software (even if it’s not WORD). Once you know something can be done, you can ask Google how to do it in your program or your version of WORD. Of course, the answer may sometimes be that it can’t be done. But most of the things we went through should be possible on most word-processors. Of course, many things are different on a Mac. Hopefully Google will help there too.
These notes will be written as instructions, as if you were typing into your own WORD document. Trying stuff out is a great way to learn what you can do, and will help you use WORD more efficiently when you prepare your submissions to this year’s anthology.
Thanks to Zita, Nora, Pati, Judy, Peter, Jean, Robin, and everyone else who contributed to Sheila’s talk at the meeting.
[bookmark: _Ref159687357][bookmark: _Toc159687880][bookmark: _Toc159688602][bookmark: _Toc159689465]Format of the Session
The session was split into four parts:
· Just write – which is what most of us do when we open a document.
· Just edit – which is what we should most certainly do next
· Things that aren’t text – consider these (pictures, text boxes, even Excel files!) the icing on the cake of your words. As Zita so wisely suggested, make sure the cake is fully baked first – make sure you’ve written and edited everything to your satisfaction before adding things that aren’t text.
· [bookmark: _Toc158738796][bookmark: _Toc158738951]Formatting for beginners – we didn’t have much time remaining to look at this. Perhaps we should have another session later in the year to look at WORD’s formatting tools. If you would like this, be sure to email admin @ portlandwritersmill . org to tell us.
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[bookmark: _Toc159689466]Just Write
So now… open a blank document in WORD. You might simply click on your WORD icon. Maybe you’ll have to select “blank document” from a list of options. (Sheila has “Sheila’s document” stored as a template, and we can look at creating your own templates later, in the formatting session.)
[bookmark: _Toc159689467]Dictation
Sheila was struggling to type with a broken wrist. Her version of WORD (WORD 365) allows you to dictate text. If yours allows for dictation it’s a fun tool to try. The dictate button was a blue microphone near the top right (top right of the home ribbon – see below for ribbons). A right light appears on it when the microphone is active.
Sheila dictated a few words to show how dictation works. She tried out special words such as “period”, “comma”, “new line” etc. Apparently, you have to be online to use dictation—logged in with Wi-Fi. If you are trying to work offline or your Wi-Fi is down, the dictation feature does not work.  If your Wi-Fi is spotty while dictating, you get some really interesting results.
With the dictation feature, you can say things like: quotation mark, question mark, exclamation point, period, new paragraph, new sentence.   If dictation makes a mistake, tell it delete, or delete, delete (to delete two words) or delete and the word you want to delete.  This also works in Google Docs!
When you say “new paragraph” you may need to start with a pause so WORD knows what you mean. 
[bookmark: _Toc159689468]Just Writing
So… Write two or three paragraphs, either by typing or with dictation. Then stop and notice how it all looks.
· First notice what happens at the end of a sentence. Look carefully. See how the space after a period is longer than the space between words. In the bad old days we had to type double-spaces at the ends of sentences, like I’m doing at the end of this (and the next) sentence.  But now WORD gives us a “bigger”, but not double, space.  This looks much better, especially when your text is left and right justified, which is why this paragraph is left and right justified. Spaces are made longer so the text lines up on both sides, and double spaces can become quite awkwardly long.
· Next look at the line spacing. It’s pretty decent – larger than single-space, smaller than double-space. It’s a nice size to work with. You will probably want double-spacing to send things to editors or publishers, but for your own “reading and writing”, double-spacing can be too distracting. (We’ll see later how to make it double-spaced.)
· And look at paragraph spacing. Paragraphs aren’t indented, but they’re nicely spaced apart – not a full line space, but a nicely visible one. Again, in the bad old days we had to leave a blank line between paragraphs. Now WORD gives us a blank part-line, which looks much better and is easier to read as you type.
All this is what’s defined in your “normal” style. So let’s find those styles, which are hiding on the “ribbon.”
[bookmark: _Toc159689469]Ribbon
At the top of your screen, you probably have a thin line with useful words like “File, Home, Insert, Draw, Design, Layout, References…. Help”. These are called your “tabs”. Below them you might see a thicker “ribbon” whose contents change depending on which word (or tab) in the line above is highlighted. If you can’t see the “ribbon,” click on one of the words, and it will appear. At the far right, at the bottom of the ribbon, there’s a small arrow. Click on it and select “Always show ribbon.” It makes life easier! 
[bookmark: _Toc159689470]Styles
With “Home” highlighted at the top, you should have a “ribbon” that includes several “blocks.” There’s a “font” block, a “paragraph” block, and a “styles” block. Notice, if you really did “just start typing,” the word “Normal” will be highlighted (with a box around it) in the Styles block. That’s because when you just start typing, you start in Normal.
Add a few headings to what you’ve been typing. Make the top heading “Heading 1” by clicking inside the text of the heading (when you type it), then clicking on Heading 1 in the styles block. Make some subheadings—Heading 2 and Heading 3. Do you like how they look? These are the default styles, and they’ll be different in different versions of WORD.
[bookmark: _Toc158738798][bookmark: _Toc158738953][bookmark: _Toc159689471]Changing your style
What if you want things to look different? Best practice is to choose a different style instead of “normal”, and we’ll see how to do that later. But for now, if you’re lazy like Sheila, you’ll just edit “normal”. (You’ll see why that’s not such a good idea as we go along, but we’re going for the “just start typing” approach here. You choose your best approach.)
· Click on the arrow at the end of the “styles” tab to open the styles controls. (If it appears as a rather intrusive box on your screen, you can double-click at the top of the box to “dock” it at the side of your screen. That looks much cleaner, especially if you’re using several styles, but it does take up space. Other docked windows might open on top of it and hide it, but you can bring it to the front by clicking on the arrow again.)
· Click inside a normal paragraph of text. You can right click on “normal” in the styles block (at the top) and select “modify”, or you can click on the right-hand square at the bottom of the styles controls (an A with a checkmark).
· This brings up a “manage styles” box. Click “modify” to change the font, size, pagination (left, right, center, both), etc. Don’t use fully paginated until you’re formatting for publishing—it changes the size of spaces and makes it harder for you to just type.
· Click on Format (at the bottom left) and choose “paragraph” to change the paragraph indentation, space between paragraphs, etc. There are lots of other options. You can play with them now or later. 
· Most likely you’ll want to increase the line spacing a bit (1.3 is nice to work with—double is what you might choose when you’re submitting your work somewhere, but it’s a bit excessive for just typing).
· Set a first-line indentation (under the heading “indentation”, choose “first line” from the options in “special”) so your paragraphs will automatically be indented to match.
· Maybe you’ll want a bigger or smaller space between paragraphs (set the “before” and “after” spacing—you’ll want these to be larger for headings than for normal text).
· Look on the second tab in the format box. This is where you can set “widow and orphan control”—it’s not perfect but it’s a good idea to keep it checked. It’s also where you can set things so that, for example, Heading 1 always starts on a new page, when you edit the headings styles.
· Changing “normal” affects the headings as well, as they’re built on “normal”. This is why you should really use a different style (body for example) but for now, we’re “just typing.” So…
· Edit the heading styles the same say to center one and move the other to the left (and make one start on a new page, just for fun!). Remember to use format>paragraph and remove the indent – center with an indent is just weird. That said, you do what works for you.
If you want things under a heading to start on a new page, it’s better to set this in the heading. You can just insert a page break (page break, near the left of the ribbon under insert), but moving things around is easier if it’s part of the style.
If, for example, you want Heading 1 to always start a new page, and Heading 2 to start a new page if it’s not straight after heading 1, you can create a new style, Heading 2A, based on Heading 2, but with a page break set in it. The new heading will behave just like Heading 2 in the Navigation Pane (below), but this is the one you will use when you want the page break.
[bookmark: _Toc158738799][bookmark: _Toc158738954][bookmark: _Toc159689472]Navigation pane (and Ruler)
Add another heading now, and look at the navigation pane. This is a pane down the left of your screen. If you can’t see it, open it by clicking on view (the view tab) at the top. Then look for “navigation” (below “ruler” and “gridlines”). Put a checkmark in navigation to bring up the pane. Maybe put a checkmark in ruler too – it can be really useful.
The navigation pane will open on “Headings” and show you an outline of your document. White arrows at the left of a heading mean that there are subheadings, not yet visible. Click on it and it turns black, and reveals the subheadings. Click on it again and it turns white and hides them.
There are two other tabs in the pane. “Pages” shows you all your pages to date, so you can click on one to go straight to it. “Results” shows you all the results of a search. And the search bar is at the top of the navigation pane. Notice the tiny arrow at the right hand side, next to the spyglass in the search bar. This is where you choose different types of searches (find-replace, go-to etc).
[bookmark: _Toc159689473]Go To
There’s an easier way to get straight to a page. Instead of scrolling through pages of text (takes forever), or through pages on the “pages” tab of the navigation toolbar (can take half of forever), click on the arrow at the right hand side of the search bar and select “go to”. This brings up a box. Choose “page” on the left of the box and type in the page number. WORD will take you straight to that page. Note, this is the “paper page”, counting from 1 on the front page of your document. When you add headers and footers and page numbers to your document, your page numbers might not be the same, as we shall see later.
[bookmark: _Toc159689474]Moving Text with Headings
Put your mouse in the navigation pane, in the headings tab, and try moving one of the headings (just click and drag). This moves the whole text under that heading. If you move, say, a Heading 2, any Heading 3 subtexts will move with it. Then move one the Heading 3s to another place, just for practice. The whole text belonging to this heading will move, so this is much easier than trying to select all the text and then click and drag it.
Using headings is more efficient than just typing “chapter one” “chapter two”, then searching for the word “chapter” etc because:
1. Sometimes you will misstype and “chapter ten” will become “chpter ten”
2. If you decide chapter one contains too much backstory and your novel should start with chapter two, you can easily move two in front of one with the navigation pane
3. If you change your mind about how your chapter headings should look, you can change them all at once by changing the heading style
4. If you want to send your book to an editor or publisher, they will want you to have used headings.
[bookmark: _Toc159689475]Moving smaller pieces of text
A single click in your text places the mouse and shows where the next thing you type will appear.
Double click selects the word. You can now click and drag that word to another location.
Triple click selects the paragraph. You can now click and drag the whole paragraph to another location.
Control C copies what you’ve selected, and you can now insert it with Control V in other locations, say, if you want to add the words “who she loved” after several different guys’ names.
Control X copies and deletes what you’ve selected, and you can now insert your paragraph somewhere else.
[bookmark: _Hlk159681674]Notice the little box that appears at the bottom right of what you’ve copied. If you’re pasting text from an email or a different document, you might want to be sure it appears in the correct font and style. Click on the arrow at the right of the tiny box and try out different options till you get what you want. (Text only—a clipboard with a letter A—copies the text but no formatting, so you would lose any italics, for example.)
[bookmark: _Toc159689476]Searching for text
Control F is the standard way to search for something. It brings up the navigation pane, open to the results tab, so if you already have navigation open, just select the “results” tab. Click the arrow at the end of the search bar (next to the spyglass) and select “replace” if you want to find and replace things. Select “advanced search” if you want to search for more complicated stuff. For advanced searches, a box pops up. Click on “more” at the bottom to search, for example, if you’re searching for the word written as it is written, with the same use of capital letters (where did I type Word instead of WORD, for example); or click on “all word forms”—for example, all word forms of “hurry” will find hurrying, hurried, hurries etc. Try it out. (We’ll look at it again when we get to editing.)
[bookmark: _Toc159689477]Undoing mistakes
Control Z undoes what you just did. Ctrl Z ctrl Z ctrl Z undoes more. Or use the backward twirly arrow at the top of your page.
[bookmark: _Toc158738800][bookmark: _Toc158738955][bookmark: _Toc159689478]How WORD helps you Type
[bookmark: _Toc159689479]Autocorrect
You probably already know that WORD tries to correct you as you type, then red-underlines misspellings and underlines questionable grammar in blue. 
If you see WORD redlining somethink, left click on the word and you’ll see the most obvious replacements. Right click to see the meanings of the replacements and find the option to add your word to the dictionary. If you have a character called Xrplflg in your novel, add the name to the dictionary and WORD will tell you whenever your misspell it—this can be really useful.
Left click selects, but you can right click on words to find synonyms as well—very useful if you want to choose a different word (to avoid repeating the same word all the time), or if, like Sheila, you can’t tell which way to spell “peel”.
[bookmark: _Toc159689480]Options
If you’re not getting any corrections from WORD, either you’re a great typist or…
Click on File>Options and a box opens. (When I type File>Options, I mean click on File—the File tab at the top left—then select Options, which is probably at the bottom left.) Select Proofing from the list on the left of the box. Look at which things have checkmarks.
Look at the Autocorrect Options too (a small box near the top of the proofing box). Note all those familiar mis-spellings that WORD corrects for you. 
There are even options to load foreign language dictionaries, and you can get WORD to check the spellings of foreign words instead of underlining them. Select your foreign word (for example, etre), then click on Review>language>set proofing language (French), but make sure you do it just for the selected text (not the whole document!), and make sure “detect language automatically” is unchecked or you can get strange results. Then click on the underlined word and find the correct spelling—être. 
You can use the options rules to add your own corrections to WORD’s autocorrect for your file. If you have to write the same thing over and over again you can create a "code" such as xxxx to be Abracadabra Delicatessen. So every time you type xxxx it will autocorrect to the full name of the company. Saves loads of time and works for other words or text or phrases. It can help when you’re taking notes too, as a sort of a quick shorthand…
[bookmark: _Toc158738801][bookmark: _Toc158738956][bookmark: _Toc159689481]Special Characters
WORD will help you type special characters:
[bookmark: _Toc158738802][bookmark: _Toc158738957][bookmark: _Toc159689482]Em and En Dashes
· Hyphen: that’s the very short dash, no spaces, in a hyphenated word like double-underline
· Endash is as “long” as the letter “n”, so longer than a hyphen. In the UK, endashes work a bit like commas and semicolons. In the US we’re only meant to use them to separate numbers. So, watch the hyphen as you type the following: Meeting (space) from (space) 1 (space) (hyphen) (space) 3. “character(s), space, hyphen, space, character(s), space or punctuation” changes the hyphen to an endash, so typing the period or space after the second character or word lengthens the hyphen into an endash. Note, there’s always a space before and after the endash.
· Emdash is as long as a “m”. In the UK it’s used for abrupt breaks in speech. In the US it’s used for that, and it replaces the way the endash was used in the UK. Again, watch the hyphen(s). In a few minutes—we’ll move on… Type “word, hyphen, hyphen, word, space” to get the emdash. The punctuation or space after the next character or word turns two hyphens into an emdash. Notice, there are no spaces, and you mustn’t type any spaces before the first hyphen.
[bookmark: _Toc158738803][bookmark: _Toc158738958][bookmark: _Toc159689483]Ellipses
Some people hate WORD ellipses. Some people love them. To create one, type three periods and a space … It doesn’t matter if there’s a space before the ellipsis or not, but having no space before makes sure WORD doesn’t break a line just before the ellipsis.
Traditional ellipses might be three periods, properly spaced, or three periods with a space between each. These will look slightly different, and you can replace WORD ellipses with them later—carefully. You don’t want a “traditional” ellipsis where there’s a line break between two of the periods, so they’re more complicated. To use WORD efficiently, keep things simple! Let WORD help. And try not to type long strings of periods—they look great on banners but not so good in printed text.
[bookmark: _Toc158738804][bookmark: _Toc158738959][bookmark: _Toc159689484]Apostrophes and Quotation Marks
You’ve all seen the quotation mark on your keyboard, right? Single quote, which serves as an apostrophe, or shift quote to get a double quote. They are not the same as straight quotes, which you might get by copying text from an email or an old document, by accidentally hitting multiple keys (e.g. if you’re wearing a brace on your wrist!), or if you’re dictating.
Sheila dictated a sentence: Tom didn't want to answer.
Then she typed: Tom didn’t want to answer.
See the difference? We can get rid of the straight quotation marks and apostrophes, and we’ll cover that in the editing section. But for now, notice that when you’re typing quotation marks (or apostrophes), WORD tries to give you the right one. How?
Tom said, “Why did you say, ‘No’?” All of these are the right way around. But
Tom said, “’No’? What kind of an answer is that?” has an incorrect single quotation mark before No.
If there’s a space or a newline before the quotation mark, WORD assumes it’s an “open quote.” If there’s a character before it (the “ in the above), it assumes a “close quote”.
To fix that second one, try:
Tom said, “ ‘No…” Adding the space forces the right quotation mark, and is standard in UK publications. In US publications, you’ll probably want to take the space out again. (And again, you don’t want the line to break between the double and single quotes.)
Then there’s: ‘Tis the season… Close quote is not the same as an apostrophe, so you’ll want to fix these too. It’s easy to type two quotes and delete one: ‘’Tis the season…
In English publications, the rule is single quote, then double quote, then triple quote mark, etc. In American ones it’s double quote, then single, then double. So:
Tom said, “Jane said, ‘No, she didn’t say, “Hello.”’” in American, but
Tom said, ‘Jane said, “No, she didn’t say, “‘Hello.”’ ” ’ in English. Wow!
To create quotation marks in dictation: After dictating a word or phrase, say “Put quotes around that” to put quotation marks around the last phrase you spoke. Say “Put quotes around <text>” to put quotation marks around the specified text.
[bookmark: _Toc158738805][bookmark: _Toc158738960][bookmark: _Toc159689485]Symbols
US and UK both use ellipses for dialog that trails off, and emdashes for dialog that’s broken or interrupted. Which is great, but WORD will happily split a line between the emdash and the quotation mark, if the end of the line happens to arrive in the wrong place. To avoid this, use a symbol.
Symbols are found on the ribbon for the insert tab. Insert>symbols>more symbols, (select more symbols at the bottom of the little box that opens, unless the symbol you want is already appearing: WORD tries to include the ones that are used most often).
A box opens. Choose normal text (on the left) general punctuation (on the right) and choose the second (slightly bolded) emdash to avoid awkward line breaks. Look at other things in the box that opened up while you’re doing this. You can do some really cool stuff! But we’re just typing…
[bookmark: _Toc159689486]Tabs
Remember, don’t use tabs to indent your paragraphs. Use styles. But you might use tabs, for example, if you are adding a header to your pages and you want the title on the left of the header and the page number on the right, or if you’re trying to do some special final formatting.
Make sure you can see your ruler (or View>rulers to make them visible).
At the left end of the top ruler is a symbol like a capital L. If you hover your mouse over it, you’ll see what it means. Click on it and it will change to an upside down T, and backwards L, a T with a dot, and more. These are different types of tabs. A left tab means the text starts where the tab is. A right tab means the text ends at the tab. A center tab centers text on the tab, and a decimal tab centers decimal points under the tab.
Tabs are connected to the paragraph style. To delete a tab setting, use the format>paragraph option (on the home ribbon or in manage styles>modify) and click on tabs at the bottom left. You’ll see the settings for each tab.
[bookmark: _Toc158738806][bookmark: _Toc158738961][bookmark: _Toc159689487]Headers and Footers etc.
Now let’s add some headers or footers to your file. You can find headers and footers in the ribbon for the “insert” tab. This, of course, is where you insert pictures, but please don’t until you’ve finished with your text. (We’ll include them in the “stuff that’s not text” section). You can insert tables (same problem). But inserting Headers and Footers is really useful right from the start, especially if you include page numbers in them. That way when the cat scatters your papers on the floor you can put them back in order. 
There are lots of types of header and footer to choose from, and life will be simplest if you just choose one rather than trying to create your own style. Do notice though, that any text you try to write on the left in the header will be indented if you changed “normal” to be indented, so you’ll have to unindent it. Likewise, those nicely centered page numbers in the footer will be indented. Maybe we shouldn’t have changed normal 
[bookmark: _Toc159689488]Page Numbers
You can add page numbers here, and you can format them – anyone for Roman numerals? When we get to the formatting section, we’ll look at how to make your page numbers start on page one of your story, rather than on the title page! If you’re submitting a piece of writing somewhere, they’ll probably have rules about page numbers and headers, but for now, just put them where you want them.
If you really, really want to DIY your header and have the title on the left and the page number on the right of the same line, insert a regular header. Type your text. Then add a right-tab at the end of the ruler (the tab will only apply to the header because it becomes part of the header style). Go to the tab and choose “page number”, choosing the “current location” option from the dropdown and “plain number” (ignore the “image” that shows it on the left—the number will appear at your current location).
Simplest, to insert page numbers in headers or footers, is just to choose the blank  style for headers/footers. To insert a page number, use the tab key to get your cursor to the place you want it in the header (set a tab stop for it as above). With the cursor blinking in the position where you want the page number, choose insert page number in current position. That way you will not tear your hair out and battle with the odd styling that confounds the issue of placing page numbers where you want them.
[bookmark: _Toc159689489]Options for headers and footers
WORD will let you have different headers (and footers) on odd and even numbered pages. It will even let you have a different header on the first page of a section. Find these options on the header tab (double-click inside your header to get there. Changing these can have unexpected results, so try to make sure they’re set how you want them. Best might be to ignore them till you’re doing final formatting.
[bookmark: _Toc158738807][bookmark: _Toc158738962][bookmark: _Toc159689490]Footnotes and endnotes
Footnotes and endnotes are added using the reference tab. You can even convert your footnotes to endnotes if you want. They update automatically, and they’re really useful.
You can also insert “cross references” from the reference tab. They’re useful if, say, you want to link this to the heading, say “References” on page 19, where you write more about it. Links can include page numbers (for printed text) and just be links (to click on) for ebooks or (Ctrl click) WORD docs. (Choose headings, and find the heading you want, and select (in the right hand box) whether you want the heading text, the page number, etc.)
[bookmark: _Toc159689491]What about Lists?
WORD helps you with other stuff too.
Try typing 1) on a new line… It starts a list. Add a second entry to your list. Maybe you wanted circles instead of numbers in front of each entry. Click on the 1) (it will highlight 1) and 2)) and choose what you want:
· First entry in my list
· Second entry…
Hit enter twice to exit the list (the first enter offers a new entry; the second tells WORD you don’t want it). 
For embedded lists, use the boxed arrow in the paragraph tab to push the embedded entry out to the right. Right arrow embeds, left brings you back. Extra lefts bring you back to the margin.
· First entry
· Second entry
· Subentry
· Another sub
· Enter, enter takes you back to the main list. But enter enter enter enter would have got you out of the list. Try it.
Lists have their own styles.  Click on one of the words in your list. Click on the tiny arrow at the bottom right of the paragraph block in the Home ribbon. (Click on Home at the top to get the Home ribbon). That “don’t add space between paragraphs of same style” thing is what keeps your lists from being widely spaced out (like paragraphs). The indentation tells you where the left margin is, and the “hanging” special indentation keeps list entries with long lines in line with each other. Try changing these just to see what happens. (“Hanging” is the third option for indentation, besides “none” and “first line”.)
[bookmark: _Toc158738808][bookmark: _Toc158738963][bookmark: _Toc159689492]What about Poetry?
Most of us type our poetry with an “enter” at the end of each line. That’s probably not ideal (shift enter would be better), but hey, we’re talking about “just start typing” here, so let’s stick with what’s natural to us. Simplest at this point is to create a new style, and call it “poem”. You could type the following to see what you get—it won’t look like this till you fix it:
This is the first line of my poem
And this is the second
Then I’ll write a third line and it will be really really really really really really really really really really really really really really long.

And here’s the second stanza.

Select the whole text of the poem. Open the “styles” box (right click on the arrow at the bottom left of Styles on the Home ribbon if you haven’t kept it open all along). A box opens up where you define your new style. Call it “poem”. Base it on “Normal”. Click “Format” at the bottom and choose paragraph. Then set the special indentation to “hanging” (so the poem lines up with the left margin, but super-long lines are indented as they go over the right edge of the page), “before” and “after” spacing to zero (so there are no paragraph breaks between lines), and OK, OK…
Now your poem should look like the one above.
What about “concrete poems”? If yours is symmetrical, it’s easy. Just create another style, based on poem, where the lines are centered (and take out that hanging indent).
[bookmark: _Toc159689493]Moving margins and Format Paint
If your poem is not symmetrical, the temptation is just to use tons of spaces. But that’s not ideal – what looks great in one font will be wrong in another. What fits one page won’t fit when the page size changes. Try typing the whole poem as “poem” then change the left indents line by line to get the shape you want. Try typing the lines below in style “poem” (so they all line up at the edge of the page):
So here’s
An arrow
Poem with
The shape
Of a right
Pointing
Arrow 

Now select the second line. Click on the small arrow at the bottom right of the paragraph block (in the home tab). Change the “left indent” to 0.5. For the next line, change the left indent to 1.0. And for the next, to 1.5.
You can continue, changing the indents for the remaining lines. But a better approach is to select the “poem with” line, click on the “format painter” (in the clipboard block—closest to the left—of the home tab—it looks like a paintbrush). Then click anywhere in the “of a right” line and it will move to match. Repeat with “an arrow” and “pointing” to get a poem shaped like the above.
[bookmark: _Toc158738809][bookmark: _Toc158738964][bookmark: _Toc159689494]What about letters or quotations?
Those left (and right) margins are great for setting off text too. Try not to change the font for just one part of your writing – it looks odd, and it makes it hard to send off to a publisher. Plus it’s hard to change consistently throughout your document. Instead, use another style, say, for a letter. Type the text below:
Dear sir
This is my first letter in this “just start typing” session. I hope you will very much enjoy reading it, and perhaps grant me some money to help toward publication.
Thank you
Sheila Deeth
Now select all the text and create a new style (just as we did for “poem”). This time set the left and right indents to 1.0 and first line (special) to 0.5. This sets off the text nicely, but perhaps you don’t want your “dear sir” to be indented. Click on this line, then on the arrow at the bottom right of the paragraph block. Remove the indent for that line. Perhaps you want “thank you” to be centered. Do the same with this line, choose center alignment (at the top of the box) and remove the indentation. To make the signature move to the right edge, do the same and choose “right” for the alignment.
[bookmark: _Toc158738810][bookmark: _Toc158738965][bookmark: _Toc159689495]What about Tables?
Tables aren’t technically text, but they’ll behave like text until you try to move them (so don’t!). You’ll find them in the ribbon on the “insert” tab. So, Insert>table and choose some number of rows and columns from the diagram that appears. Type some text in your table entries. Use TAB to move from one slot to another. TAB from the bottom right slot will add another row to the table. You can:
· Change the width of a column by clicking at the column boundary (watch the mouse—line—change to a double-bar) and dragging the bar.
· You can center text in a column—
· click at the top of the column (the pointer should look like a down-arrow) so the whole column is selected (goes gray), 
· then choose paragraph from the popup list of options, or use the controls in the “home” tab in the paragraph block.
· Add a tab button within this column just as you would add tabs elsewhere (see earlier)
· Add a new column by 
· selecting a column (click at the top again)
· right click on the column and choose “insert column” (before or after), or
· Notice how there are now two new entries in the list of tabs—Table Design and Layout
· Click on Layout to get the layout ribbon
· Choose insert column from the ribbon
· Note how column widths change to fit your new column
· Remove the right hand column in the same way (choose delete). Now your table doesn’t fill page.
· Make your table fit the page by clicking in the table. Go to the Layout tab and select autofit, choosing autofit window from the options. Try out the others too—you can make all your columns the same size again, amongst other things.
· If you’ve messed up your column widths and want to them looking tidier, click “distribute columns” to the right of autofit. “distribute rows” does the same for your rows.
· You can set the top line of your table to be a “header” so it repeats when the table goes over a page, and so it’s not affected by attempts to order the table contents. (After all, “first name” should usually stay at the top, not appear between “Elizabeth” and “Jean”.) 
· Select the top line. 
· Right click and choose table properties (at the bottom of the list)
On the “row” table, notice the block that allows entries to break across pages. This is a real pain and you should unset it for the whole table.
· Notice just below that is the option to set this row as a header, so select it.
· Now try to order the entries in your table. 
· Click inside the table. 
· Click on the layout tab (top right)
· Click on A-Z sorting (near the right hand of the layout ribbon)
· Choose which header column you want to order by (choose more than one to “sub”order), set the right type (if it’s a number, make sure it knows it’s number, not date!), and choose whether you want increasing or decreasing order.
· Under price (or whatever numerical entry column you created), set a decimal tab in the same as tabs were set before. Then all the decimal entries in the column will line up!
· You can change the size of text in the table, bold it, italicize it, etc, column by column, row by row, or the whole table at once. To select the whole table, click on the box with the cross in it that appears at the top left when your mouse is inside the table.
	First name
	Last name
	First book
	Genre
	Price
	Read?
	Rating

	Ace
	Zed
	Best in the whole wide world
	Fantasy
	1000.99
	X
	

	Sheila
	Deeth
	Divide by Zero
	General fiction
	14.99
	Y
	4

	Jean
	Harkin
	Promise Full of Thorns
	Historical fiction
	18.99
	y
	5


· You can change how the table appears. Click inside the table then go to the table design tab. Toward the left of the ribbon you’ll see “border styles” and “borders”. Try clicking on the “borders” box to remove all the borders and just leave the table content visible.
· You can move the table by dragging the box with the cross in it. But now you’ll run into all the problems you would have with images and other things that aren’t text (see later).
[bookmark: _Toc159689496]And Columns
Sometimes you’ll want to add some text in columns. Click on “layout” to open the layout tab. Then click on “columns” to choose how many columns you want. Be careful with columns—there can be unexpected formatting problems, as there’s a lot going on behind the scenes. Simplest is to type your text as a long list. Select the whole list. Layout, columns, 2 (say) and the list will split into two columns.
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Try this
And this
And this
For a few
More lines
Then say
You want
Two columns
[bookmark: _Toc158738811][bookmark: _Toc158738966]
[bookmark: _Toc159689497]Editing Your Text
It’s a fact of life, we all make mistakes. Plus we all have files lying around on our computers that we typed up before we really knew what we were doing. So now we need to edit.
[bookmark: _Toc158738812][bookmark: _Toc158738967][bookmark: _Toc159689498]Special Characters
A few more special characters come into play now.
· Did you start every paragraph with a tab? You’ll need to remove tabs.
· What if you started with a string of spaces? You’ll need to remove them too.
· And if you ended every paragraph with a blank line?
· Those double spaces at the end of sentences?
· Ellipses that are random strings of periods……….
· Straight quotation marks
· Plus some funny spaces and line ends where you hit ctrl shift space or shift enter?
[bookmark: _Toc159689499]How to see the formatting
Click on the formatting symbol (a backward P on the Home tab) to see what you’ve really typed. Spaces appear as dots. “Unbreakable spaces” (see below) are circles—they’re useful, but they’re also accidental when you’re copying from emails. Tabs are right arrows. You don’t want tabs at the starts of paragraphs, but you do want them in lists. Manual line breaks look like square left-pointing arrows.
[bookmark: _Toc159689500]Caret Codes for Special Characters
Zita gave us a list of carat codes. Type these in the search bar to find where the characters are in your document:
· ^12 or ^b is a section break (we’ll look at sections later)
· ^m is a manual page break (insert>page break)
· ^13 or ^p is Carriage return/paragraph mark
· ^14 or ^n Is Column break
· ^? Is a character (e.g. if you’re looking for endashes with no space before the next character)
· ^- is an Optional hyphen (e.g. if you’re telling word “this is where you can break with word”)
· ^~ is a Nonbreaking hyphen (telling word not to break the line at this hyphen, e.g. in double‑spaced)
· ^^ is the Caret character (for when you want ^ to just mean ^ in a search)
· ^+ is Em dash
· ^= is En dash
· ^s is a Nonbreaking space (used to stop the line breaking between WORD, War, and II or example)
· ^034 is a straight (double) quotation mark
· ^039 is a straight single quote
· ^0nnn (for different digits nnn) is how you look for other things by their ASCII character number
Here is a website link to help with the codes when doing Find and Replace: https://erinwrightwriting.com/how-to-find-and-replace-special-characters-in-microsoft-word/ 
[bookmark: _Toc159689501]Creating special characters
Sometimes you’ll create special characters deliberately, so don’t go overboard getting rid of them.
· Typing “World War II” (with control shift spaces instead of just spaces) means WORD won’t break a line between these words, which makes things easier to read.
· Typing . . . (periods with control shift spaces) creates a standard (but unbreakable) “long” ellipse. If these are the sort of ellipses you want, replace WORD ellipses with this in advanced search (search for ^i and replace with ^s.^s.^s. )
· Typing (shift enter)
at the end of lines of poetry gives you manual line-breaks (not paragraph breaks) and might get rid of the need to create a new style. This would mean you didn’t need blank lines at the end of each stanza – just paragraph breaks.
· You create the tabs in lists just by creating a list.
· You create WORD ellipses by typing three periods followed by a space
· You create an emdash by typing two dashes (no spaces before or after) and continuing with another word or character and a space
· You create an endash by typing a space, a dash, a space, a character or word, and a space.
· You can also make an em dash in WORD by pressing the Ctrl key, Alt key, and the minus sign (on the numeric keypad) simultaneously. Be sure NOT to use the hyphen on the main keyboard! On a Mac, click Option, Shift, and the hyphen key to make an em dash.
[bookmark: _Toc159689502]Removing special characters
Removing unwanted special characters is something you should do before you even bother to read your text. To do this, you’ll use “Find>Replace” in WORD.
	Here’s a paragraph starting with a tab and ending with a manual line break

     Here’s one starting with spaces.  I’ve put two spaces at the end of the sentence, and I’ll end with a long string of periods………
You might want to type some paragraphs this way to practice editing.
Search for (Control F, or, if your navigation pane is open, just type in the search bar:
· ^t for tabs. You’ll probably replace them with nothing, but watch out for lists
· ^s for unbreakable spaces. You’ll replace them with spaces, but watch out for ones you want to keep
· “space space” and replace with “space” repeatedly
· ^l for manual line breaks. You’ll replace these with paragraph breaks (^p), except in poetry
· ^p^p for blank lines at the ends of paragraphs
· ^034 for straight double quotes
· ^039 for straight single quotes
And then, if you want,
· look for emdashes (^+) and make sure they don’t have spaces around them.
· Look for endashes (^=) and change them if they’re meant to be emdashes
· Look for ellipses (^i) and make sure they all follow the same rule (e.g. no space before, no punctuation after)
[bookmark: _Toc159689503]Find, Find/Replace, and Advanced Find
You probably won’t remember the caret codes but you don’t need to.
· Google knows them. Just ask. And
· If you click on the arrow next to the magnifying glass in the search bar, you can choose “advanced find.”
· Click on “more” at the bottom left to open up lots of options
· This is where you can ask to match the word precisely (if you’re looking for where you typed a name without a capital letter, for example)
· Find words that “sound like” (yes, really!) and all word forms (hurry, hurries, hurrying, etc)
· Click on “format” then “font” at the bottom and you can look for everything in italics, everything underlined, everything in Times New Roman, etc.
· Click on “special” and you can look for special characters without knowing their codes.
If you decide you want to change a character’s name, choose “replace” from the options when you click on that arrow.
And if you just want to find everywhere you said “So she” just type “so she” in the search bar, and open the results tab of the navigation pane to see them all listed. This is great if you know you overuse certain words.
[bookmark: _Toc159689504]Editing Tools
So, now you’ve “cleaned up” your text (without really reading it), and it’s time to read and review (and make changes). It’s a really good idea to save your file to a new filename (e.g. MyfileRev1), so you can compare the original file with the revised one and see what changes you made.
[bookmark: _Toc159689505]Compare Files
Click on the “review” tab at the top of word, and some great editing tools will appear. Near the right-hand edge of the ribbon is “compare” which opens a box where you can choose what files to compare and how to compare them—do you want to note formatting changes or just text changes, etc. It’s a really useful way to make sure you didn’t do anything crazy by accident.
[bookmark: _Toc159689506]Track Changes
Another very useful too is “track changes”. Click on this and type a change into your document. The change appears in red, and anything you delete will be crossed out in red, just as if you were reading your document on paper and red-penciling the changes. Try moving some text. The original text will be crossed out in green, and the text in the location is typed in green. It’s easy to see the changes you’ve made, and they’re not permanent until you “accept” them (see below). 
And I’ll move this second sentence in front of the first.I’m going to delete delete the repeated word. And I’ll move this second sentence in front of the first.
[bookmark: _Toc159689507]Add comments
There’s a “new comment” button, and you can click on text and add comments, like notes made in the margin when you read the printed page. These can help you remember why you made a change, or tell you what to check for (are her eyes always blue) on the next read-through.
[bookmark: _Toc158738814][bookmark: _Toc158738969][bookmark: _Toc159689508]Modern comments
WORD recently introduced Modern Comments. They’re great for collaboration, but we’re writing, not collaborating, and Modern Comments separates the changes you made from the comments you wrote explaining the change, which is a real pain. Switch them off with File>Options>General and make sure modern comments is not selected.
[bookmark: _Toc159689509]Read aloud
Everyone says you should hear your writing read aloud to help editing. WORD (at least WORD365) can read aloud for you. Select a paragraph, then Review>Read aloud.
[bookmark: _Toc159689510]How will it look?
Sometimes all those changes make it hard to read the underlying text. Still on the review ribbon, look at the small box that says “all markup”. Change this to “no markup” to see how the text will appear if you accept the changes.
Some changes are hard to make in “all markup” mode—changing hyphens to emdashes for example. Changing to no markup lets you make these changes, then switch back to “all markup”.
[bookmark: _Toc159689511]Accept and Reject changes
When you’ve made your changes, review them. The Previous and Next buttons let you follow through both the changes and the comments. Then accept and reject… Note there’s an option to accept and move to next, and another to just accept. You might like to just accept so you can see what happened when you made the change.
[bookmark: _Toc159689512]Working with (or as) an Editor
An editor will probably use “track changes.” You, as the author, will then need to be able to see those changes. Go to “review” “all markup” and they’ll appear. Often you will engage in dialog with the editor (a conversation in the margins) to discuss what you do and don’t want to change.
[bookmark: _Toc158738815][bookmark: _Toc158738970][bookmark: _Toc159689513]WORD Count, Spelling, Grammar
Review also gives you access to spelling and grammar checks, word counts (useful if you’re submitting to something with a wordcount limit). Don’t forget to save your edited file to a new version, then use compare to compare two versions and see if your changes all make sense. If you’re cutting words, it’s especially important to keep your original in case you cut too deep.
[bookmark: _Toc159689514]Different Versions of WORD
There can be issues when your editor uses a different version of WORD from you, lives in a different country (!), or when your file is really, really old. Your formatting may look different on their machine—WORD changed the size of the fonts at one point, and different countries use different standard sizes for paper. So don’t expect things like images or text boxes to look right—we’ll look at them next, but there’s a reason we try not to add them till the end—they’re not text.
[bookmark: _Toc159689515]WORD Editor
WORD gives you a great “review” assistant for editing (at least, modern versions do). The button labeled Editor at the far left of the review tab brings up an analysis of what you’ve written. 
Just below the Editor score is a place to choose formal writing, casual writing, or professional writing.
Click on spelling to go through the spelling queries one by one. WORD will offer suggestions to fix the “error”, but you get to choose if you want to ignore it, change it, add it to the dictionary, etc. Then there’s the grammar checker—find all those missing commas! Clarity offers simpler ways to say some things. And there’s even an inclusiveness check!
Document stats may take a while, but it gives you good stats on sentence length, Fleisch Kincaid scores, reading grade level, and more!
[bookmark: _Toc158738817][bookmark: _Toc158738972][bookmark: _Toc159689516]Stuff that’s not Text
[bookmark: _Toc159689517][bookmark: _Toc158738818][bookmark: _Toc158738973][image: A painting of a porch with trees]Images
Remember, WORD is a word processor. Pictures are not words. That said, you can do a lot with pictures in WORD, so let’s look.
[bookmark: _Toc159689518]Add an Image
Add an image, say, nicely centered in your text:
· New paragraph
· Set the paragraph style to centered with no indentation
· Open the Insert tab at the top of your WORD screen. Insert>Pictures> and choose stock pictures, images on your computer, etc.
· The picture will appear nicely centered below your text. You can continue typing below the picture.
· You can edit or approve the “alt text” which is what will appear, say, in an ebook if it can’t display the picture. 
· You can drag the corner of the picture to make it fit on the page. 
· But you can’t move the picture.
If you must add pictures before the editing is complete, this is by far the safest way.
[bookmark: _Toc159689519]Move and Edit an image
WORD will help you position the image in other ways. Just be aware that moveable images can move when the text moves, and getting them back to the right page might take lots of slow steps instead of the obvious click and drag.Figure 1

· Click on the image. A new tab labeled “picture format” appears next to HELP.
· Click on “position” (toward the right-hand side of the picture format ribbon) and you’ll see how WORD might place the image at the top left, top right, bottom left, etc. Once this is done, the picture is moveable.
· Click on “text wrap” and find lots of cool options. You can even hide your picture behind the text (as here), but if you’re doing that, you’ll want to fade the colors a bit.
· Click on “transparency” near the left-hand edge of the ribbon to fade the image.
· Try out some of the other buttons for cool effects. You can change the borders of the image, change its shape, 
add shadows, change the brightness.
· Nearly transparent images, set behind the text, make good background images. But formatting for print is complicated and you’ll have to jump through a few more hoops.
Remember to use the ruler (View>Ruler) so you can position the image to fit in the written part of the page. 
[bookmark: _Toc159689520]Anchor
When you click on an image, a small box appears to the top right of it. You can click here for layout options (as above). But more important is the little blue anchor that appears to the left of your text. This is the “anchor” for your image, and it might not even be near the image. Right click on the image and choose “size and position.” This is the info stored in the anchor, and the anchor moves with the text so… when you add text, the anchor can drop down the page, and the image can drop down so far it’s invisible. i.e. Your image “disappears.” So… don’t add moveable images till you’ve finished changing the text if you want to be efficient!Figure 2: A great picture

[bookmark: _Toc159689521]Compress Pictures
Images can make your WORD doc much bigger, which makes it slow to send in emails, possibly too big for some email systems, and costly on your email storage space. If you’re sending a doc around with pictures just to show your beta readers what it will look like, you might want to Compress Pictures: for documents with many pictures, you can reduce the file size with this button on the Format Picture tab. Select any picture in the document, click this button, and then choose your preferred resolution. For files that need to be sent by email and don’t need high-resolution photos, "web" or "email" are fine choices. For a document that will be printed but doesn’t need every photo to be 15MB, choose "print" quality to reduce the image sizes without losing too much resolution. You can also uncheck the default selection for "apply only to this photo," which will then apply your choices to every photo in the document.
If you’re going to upload the final file to Amazon, say, for printing, they will want 300DPI images. Maybe have two versions, one with compressed and one with full images.
[bookmark: _Toc159689522]Captions
Right clicking on your image also gives you the option to add a caption. Try it out. The caption ends up in a small text box below the image. If you move the image, it will leave its caption behind. If you select the image and the text box both together (click on one and control click on the other) they will move together. When both are selected, go to the “shape format” tab (next to picture format) and look at group (at the far right). This lets you “glue” them together for future moves.
[bookmark: _Toc158738819][bookmark: _Toc158738974][bookmark: _Toc159689523]Text Boxes
Text boxes (like those image captions) may contain text, but they are not technically “text” and they will behave more like images. Which means they too will jump all over the page, fall off the page, and generally drive you crazy. 
Click on Insert and choose text box from the ribbon. WORD gives you some cool default text (which you should change, of course:
[Grab your reader’s attention with a great quote from the document or use this space to emphasize a key point. To place this text box anywhere on the page, just drag it.]



Sounds simple, doesn’t it…
[bookmark: _Toc159689524]Tables
We mentioned tables earlier. If you start moving tables around, rather than leaving them where they were created, they’ll behave like pictures and jump all over the place.
[bookmark: _Toc159689525]Excel Files
Peter says you can even insert Excel files into WORD docs, and still edit them within WORD! Again, I’d suggest you don’t try moving them around!
[bookmark: _Toc159689526]When Not to Use Text Boxes
The real pain, from our point of view as a multinational writing group, is that standard pages in the UK are a different size from in the US. So… if you send us a file with text boxes (or with images), what we receive may not be anything like what you sent.
If you’re trying to position the stanzas of a poem in different places on the page, it might be tempting to put them in text boxes and move the boxes around to get the effect you want. But please, use “indentation” and “margins” in the paragraph style instead, as in the example below.
This first stanza
Is flush with the left margin

But my second stanza
Has moved toward the center

And my third
Has moved even more

But I’ll place the fourth back at the margin.

[bookmark: _Toc158738821][bookmark: _Toc158738976][bookmark: _Toc159689527]Formatting for Beginners
Now it’s time to look at formatting for print—except we were running out of time in the meeting, so, please let us know if you want this covered in greater depth. Zita and Sheila would love to cover it in greater depth, because then someone might be ready to volunteer to help format the anthology. You would be able to format and self-publish your own books too—wouldn’t that be good?
Again, WORD is a word processor. The fact that you can format for print is pretty incredible. We should be grateful for what WORD gives us, rather than complaining at what it doesn’t. So, sure, it can be a pain to format your book. But it just might be something you’ll learn to love.
[bookmark: _Toc158738822][bookmark: _Toc158738977][bookmark: _Toc159689528]Page size, margins and gutters
You’ll probably download a “template” for the book you’re trying to create. Use google to find where Amazon hides them. They’re free and really easy to use. But it’s good to know what’s in that template so you can fix it to work best for you.
Open your template and click on that “layout” tab at the top of WORD. Margins is a good place to start (it’s at the left of the ribbon). Click on the arrow below Margins and you’ll see lots of options for standard left/right/top/bottom margins. Choose custom margins at the bottom of the list to see more detail.
A box opens at the “margins” tab. In a template for a printed book, there will be the usual left/right/top/bottom margins, plus a “gutter” which gives a bit of extra space in the middle of the book (where the glue holds it together). Mirrored margins make sure this extra space is always in the middle (kind of important!). And the “rules” will normally be applied to the whole document (though you can apply different rules to different parts if you must).
Click on the next tab in this box to see the page size. This might be something like 6 x 9”, not the same as WORD’s default page size. If you were using one inch indentation for your paragraphs, you would certainly want to change your style to use something smaller (say half an inch). Changing the style changes everything that was written in that style in one go—part of why using styles is an efficient way to work with WORD.
The third tab is “sections”, headers and footers (how much space they will be given on the page), and other good stuff. Having sections start on odd pages, and using different left and right headers, will make for a more professional looking book.
When you’ve downloaded your template, you can either copy the layout information to your own document, or you can cut and past the contents of your document into the template file. You can make your own template files too, or download and customize a template:
· Open word with a blank document, or a template file
· Set up the styles you’re going to want
· Set up the layout (page size, margins, etc) (this will already have been done in the template)
· Maybe write yourself a few instructions. Type TITLE on the front page, copyright info on the next, dedication on the next, etc. If you’re using an Amazon template, all these things will already be there to guide you.
· Then save the personalized template—File, Save as, then click on the arrow next to the words “word document.” There are lots of different ways to save a file. Pick “word template” and your file will now be a template, ready for you to choose whenever you open WORD!
[bookmark: _Toc158738823][bookmark: _Toc158738978][bookmark: _Toc159689529]Sections
The best way to understand sections is to use them. So it’s time to add some sections to your document, maybe before each major heading. We’d like each section to start on a “left facing” odd-numbered page of our “book” so…
· Position your mouse (cursor) at the end of the text that comes before the heading.
· Click Layout at the top of the screen.
· Click on “breaks” and choose “section break, odd page”
· Click on the backward P to see it represented on the screen.
When you look at your text in WORD, the new section will simply start on a new page. But it’s an odd-numbered page, so there may be a blank page in front of it (WORD won’t display the blank page). The great thing about using sections is that the blank page will be truly blank—it won’t have a page number or other stuff written on it, and this looks more professional (which is good).
Be careful about setting your section breaks. If you set one to the “wrong” sort, then take it out, all sorts of things can go wrong.
Also… you may have to set “mirror margins” to make WORD honor the “odd page” designation (or it can’t tell what’s odd? That’s odd).
[bookmark: _Toc158738824][bookmark: _Toc158738979][bookmark: _Toc159689530]Page Numbers
We probably don’t want to have a page number, or a heading, on the front page. This means you might want different headers and footers in different places. Add a nice front page to your document and start a new section after it.
Double click in the header or footer space of the first page of the section where you want page numbers to appear. This brings up the ribbon for the header and footer tab. (You could also just go to insert>header>edit header to get to the same place.)
Notice the highlighted “same as previous” near the middle of the ribbon. Click on this to unhighlight it. If you don’t unlink your headers, any changes you make will happen in the previous section, and all sorts of chaos can ensue.
Add a page number (if you haven’t already) and click on page-number>format page number. Choose a starting number (1).
[bookmark: _Toc158738825][bookmark: _Toc158738980][bookmark: _Toc159689531]Headers and Footers
You probably don’t want a header, footer, or page number on the front page. After unlinking the headers (see page numbers above), double-click in the header for the front page and delete everything. Since you’ve “unliked” the headers, this should not mess up the header in the next section.
You might not want headers on the starting page of a section either, but should probably have some on subsequent pages – maybe different on left and right pages. Double click on the header in a section where you do want headers and footer, and look at the words “different first page” and “different odd and even pages”. Putting checkmarks on these lets you set up very cool looking headers. Remember to unselect the “same as previous” button when you’re making changes that should only apply to one section.
[bookmark: _Toc158738826][bookmark: _Toc158738981][bookmark: _Toc159689532]Pretty Formatting
You can format your headings (which are not headers… life is so confusing) in all sorts of clever ways for your printed book. Let’s format a level 4 heading, just for fun.
Type something and make it Heading 4.
Edit the style, just as we did earlier. But this time, under “format” choose “border” and play with the options. Just have fun.
A boxed in heading
Maybe center the text in the box to look better.
[bookmark: _Toc158738829][bookmark: _Toc158738984][bookmark: _Toc159689533]Justification
Stuff that you send out in submissions should only be left-justified, which is probably what you’ve been using so far. Stuff that you publish will be left and right justified. So it’s time to change your “normal” or whatever your basic style is.
Position the cursor in some normal text. Right click on normal (highlighted in the styles block). Click modify, and change the justification (just choose the button that looks like printed lines).
[bookmark: _Ref159687228][bookmark: _Toc158738830][bookmark: _Toc158738985][bookmark: _Toc159689534]References
The reference tab is where you’ll find controls for footnotes, endnotes, cross-references, tables of figures (if you added captions to images), tables of contents, etc.
[bookmark: _Toc159689535]Contents List
A table of contents can be added using the reference tab as well.
· Position your cursor where you want the table of contents.
· On the reference tab, choose “table of contents” (at the left), and pick a style. 
· You are free to create your own style, choosing how far down the list of headings (1,2,3,4) you wish to go, and whether you want dots or blank space between the contents and the page number (or even if you want page numbers).
· The contents page is added, and each heading links directly to the page in your document, so you can control click on a chapter heading to go straight to the chapter.
· If the contents page doesn’t look right / doesn’t fit on the page / is too spaced out, just select it and use the paragraph block (small arrow at bottom right of the block) to change the line spacing, font size, etc.
· Remember to update the page numbers (choose update numbers or update all) in the contents whenever you change anything
[bookmark: _Toc159689536]Good form
Good form is making your text appear pleasing to the reader. You shouldn’t have pages with just one or two lines of text, for example, or lines with just one word at the end of a paragraph. WORD does a great job of making stuff look good, but you have to “finish” it yourself.
Look for a paragraph with just one word on the next line. Shift enter, somewhere earlier in the paragraph, will move more words down and make the spacing and white space cleaner. You might need to repeat it on several lines to get the effect you want. But REMEMBER, don’t do this to the version of the file that you plan to use for the ebook. It would really mess it up!
Where one or two lines (say, of a poem) go over a page, you can change the line spacing a little, change the font size maybe—just changing the font size for those blank lines between stanzas might fix it.
Or you can add a picture. But be careful. Remember pictures can move.
[bookmark: _Toc159689537]Save as PDF
You will probably plan to upload a PDF file to Amazon when you publish your book. So now it’s time to save it as a PDF file. Under File, chose Save As and use the dropdown (where is says WORD document) to choose PDF file.
The PDF file will display all those blank pages between sections. To view it like a book open the PDF file, choose Menu, View, Page Display, Two page view and Show cover and no scrolling








Many thanks to everyone who helped with this, and we hope you’ll find this document useful. Feel free to share it, but please credit the Portland Writers Mill with its creation. (Oh, and I made this box by adding borders (in the paragraph block) to the paragraph.
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